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Nikon SERVICE FACILITIES (As of March i< 

Argentina: Eduardo Udenio y Cia. 
S.A.C.I.F.I. 

Australia: Maxwell Optical 
Industries Pty Ltd. 

Belgium: N.V. H. de Beukelaer & Co. S.A. 
Brazil: T. Tanaka & Cia. Ltda. 

Canada: Nikon Canada Inc. 

Chile: Reifschneider Foto S.A.C. ei. 

Czech Rep.: Nikon SRO 
Denmark: Dansk Fotoagentur, A/S 
Finland: Nikon Svenska AB 

Finnish branch office 
France: Nikon France S.A. 

Greece: D. & J. Damkalidis S.A. 

Germany: Nikon GmbH 

Hong Kong: Nikon Hong Kong Ltd. 

Hungary: Nikon Kft 

India: Mazda Camera Centre 

Photo Vision 

Capital Electronics 

Indonesia: PT Alta Samaraya 

PT Indonik Kandi 
Ireland: Nikon U.K. Ltd. 

Israel: Hadar Photo Supply Agencies 
Ltd. 

Italy: Nital S.p.A. 
Kuwait: Ashraf & Co., Ltd. 

Malaysia: Shriro (Malaysia) 
Sdn. Bhd. 

Mexico: Mayoristas Fotograficos, 
S.A. de CV. 

Netherlands: Inca Import B.V. 
New Caledonia: Phocidis 
New Zealand: T.A. Macalister Ltd. 
Norway: Intertoto A.S 
Poland: Camera Sp Z.O.O. 
Reunion: Dimaciphot S.A. 

Ayacucho 1235, Buenos Aires (1111) 
Phone:+54-1-8150687 
Unit 4 Northbank Industrial Park 
20-36 Nancarrow Avenue, Meadowbank, NSW 2114 
Phone: +61-2-9390-0200 
Boomsesteenweg 77, B-2630 Aartselaar Phone: +32-3-8705900 
Rua Martim Francisco, 438, 01226-000, Sao Paulo-SP 
Phone:+55-11-8252255 
1366 Aerowood Drive, Mississauga, Ontario L4W 1C1 
Phone:+1-905-6259910 
Jose Manuel Infante #1639, Casilla 4216, Providencia, Santiago 
Phone: +56-2-2049030 
Kodanska 46,100 10 Praha 10 Phone: +420-2-6715 4560 
Lerso Parkalle 101, DK2100 Kobenhavn Phone: +45-39-162020 
Ojahaanrinne 4, 01600 Vantaa 
Phone: +358-9-5660060 
191, Rue du Marche Rollay, 94504 Champigny Sur Marne Cedex 
Phone:+33-1-45164516 
33 Xariton Street, 175 64 Paleo Faliro, Athens 
Phone:+30-1-94 10 888 
Tiefenbroicher Weg 25, 40472 Dusseldort 
Phone:+49-211-94140 
Suite 1001, 10F, Cityplaza One, 1111 King's Road, 
Taikoo Shing Phone: +852-2902-9000 
Devai Utca 26-28, H-1134 Budapest 
Phone:+36-1-350-5525 
306, Veena Killedar Bldg., Pais Street, 
K. Khadye Marg, Bombay (Mumbai) 400 011 Phone: +91-22-3079284 
223, Okhla Industrial Estate, New Delhi 110020 
Phone:+91-11-6831936 
12, J.LNehru Road, Calcutta-700 013 
Phone: +91-33-2280091, 2285857 
Arkade Belanja Dusit mangga Dua Ruko 
No. 16, Jl. Arteri Mangga Dua Raya, Jakarta 10620 
Phone:+62-21-6127654 
Jl. Tomang Raya No. 49.B, Jakarta 11440 Phone: +62-21-5600974 
380, Richmond Road, Kingston, Surrey KT2 6PR 
Phone:+44-181-541-4440 
P.O. Box 1686, Tel-Aviv 61016 
Phone: +972-3-5603947 
Via Tabacchi 33,10132 Torino Phone: +39-11-8996804 
P.O. Box 3555, Safat, P. Code 13036-Safat, Kuwait 
Phone: +965-5312960-8 
Lots 22 S 24, Jalan 225, Section 51A, 46100 Petaling Jaya, 
Selangor (P.O. Box 10571,50718 Kuala Lumpur) Phone: +60-3-7749842 
Dr. Jimenez 159, Doctores, D.F. Mexico City, 
Mexico 06720 Phone: +52-5-5887011, 5884744 
Rutherfordstraat 7, 2014 K.A. Haarlem Phone: +31-23-5101910 
BP 661, 98845-Noumea Cedex Phone: +687-28-6670 
65-73 Parnell Rise, Auckland Phone: +64-9-3034334 
O.H. Bangsvei 51, N-1322 Hovik Phone: +47-67-534990 
UL, Tamka 38, 00355 Warszawa Phone: +48-22-8281255 
1, Rue Robert Shumann, Zi n 3, BP268, 97826 Le Port Cedex 
Phone: +262-42-45-50 

NIKON CORPORATION, Tokyo, Japan 

Saudi Arabia: Ahmed Abdulwahed 
Abdullah Trading 
Establishment 

Singapore: Shriro (Singapore) 
Pte. Ltd. 

Spain: Finicon S.A. 

Sweden: Nikon Svenska AB 

Switzerland: Nikon AG 

Taiwan: Yang Tai Trading Corp. Ltd. 

Thailand: Niks (Thailand) Co., Ltd. 

U.A.E.: Grand Stores 

United Kingdom: Nikon U.K. Ltd. 

Uruguay: Micro S.C. 

U.S.A.: Nikon Inc. 

Vietnam: Pham The Camera Repair 
Center 

Yugoslavia: Refot B 

Japan: NIKON CORPORATION 
Ohi Service Sec. 

Sapporo Service Center 

Shinjuku Service Center 

Nihonbashi Service Center 

Yokohama Service Station 

Nagoya Service Center 

Osaka Camera Service Sec. 

Osaka Umeda Service Station 

Fukuoka Service Center 

P.O. Box 3611 Jeddah 21461 (Postal Address) 
Hail Commercial Centre, 3rd Floor, 1-5, Hail 
Road, Beside Caravan Centre, Jeddah 
Phone: +966-2-6425333/6425777 
11 Chang Charn Road, #06-01 Shriro House 
Singapore 159640 Phone: +65-4727777 
Calle Laforja, 95, Pral. 3a, 08021 Barcelona 
Phone: +34-93-2402121 
Calle Reina Marcedes, 7, Madrid-20 
Phone: +34-91-5539392 
Anton Tamms Vag 3, Box 84,194 22 Upplands-Vasby 
Phone:+46-8-59410900 
Kaspar-Fenner-Strasse 6, CH-8700 KusnachtyZH 
Phone:+41-1-9136111 
6F, 90 Huai-Ning Street, Taipei 10037 
Phone: +886-2-2311-7975, 2311-3480 
166 Silom Road 12, Bangkok 10500 
Phone: +66-2-235-2929 
Saleh Mohammed Bin Lahej Bldg., Al Garhood, P.O. Box 2144, 
Deira, Dubai Phone:+971-4-823700 
380 Richmond Road, Kingston, 
Surrey KT2 5PR Phone:+44-181-541-4440 
Casilla Correo 27, Avda. 18 de Julio 1202, Montevideo 
Phone:+598-2-915516 
1300 Walt Whitman Rd. Melville, NY 11747-3054 
Phone: Repair Service; +1-800-645-6678, 
General Questions (Consumer Relations); +1-800-NIKONUS, 
Computer related technical support; +516-547-4311 
11 Le Cong Kiue St. Dist. 1, Saigon City 
Phone: +84-8-829-5888 
Pcinjska BR. 12,11000 Beograd 
Phone:+381-11-4448652 

6-3, Nishiohi 1-chome, Shinagawa-ku, Tokyo 140-8601 
Phone:+81-3-3773-2221 
Ohdori Bldg., 2F, 1-13, Ohdorinishi, Chuo-ku, Sapporo 060-0042 
Phone:+81-11-231-7896 
Shinjuku NS Bldg., 5F, 2-4-1, Nishi-Shinjuku, Shinjuku-ku, Tokyo 163-0805 
Phone:+81-3-5321-4466 
Nihonbashi First Bldg., 9F, 2-19, Nihonbashi 1-chome, Chuo-ku, Tokyo 103-0027 
Phone:+81-3-3281-6810 
TS Plaza Bldg., 4F, 2-23-2, Tsuruya-cho, Kanagawa-ku, Yokohama 221-0835 
Phone:+81-45-312-1101 
Chugai Tokyo Kaijo Bldg., 6F, 3-20-17, Marunouchi, Naka-ku, Nagoya 460-0002 
Phone: +81-52-954-0122 
Daisanshoho Bldg., 8F, 2-2-3, Nishishinsaibashi, Chuo-ku, Osaka 542-0086 
Phone: +81-6-6212-7026 
Shinsankei Bldg., 1F, 2-5-2, Umeda, Kita-ku, Osaka 530-0001 
Phone: +61-6-6348-9730 
Hakata Ekimae Daiichi Seimei Bldg., 1F, 1-4-1, Hakata Ekimae, Hakata-ku, 
Fukuoka 812-0011 Phone: +81-92-415-6350 
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IMPORTANT - READ CAREFULLY BEFORE OPENING 
By opening the sealed storage media package, you indicate your acceptance of the following 

Nikon 
License Agreement 

Nikon Corporation. License Agreement 
You should carefully read the Nikon License Agreement contained herein before opening the storage media package or breaking the seal on the 
storage media. BY OPENING THE STORAGE MEDIA PACKAGE, YOU INDICATE YOUR ACCEPTANCE OF THIS AGREEMENT AND ARE 
AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT. If you do not agree to the terms of this agreement, do not open the 
storage media package or break the seal on the storage media. Promptly return within fifteen (15) working days from the date of delivery this 
unopened package to the store (the authorized Nikon Dealer in the U.S.) where you obtained it for a full refund. If you decide to retain and use the 
enclosed computer program and related documentation ("Nikon Software"), in consideration of the payment of the license fee, Nikon grants to you 
a non-exclusive license to use the Nikon Software only under the terms stated in this agreement. This license is not a sale of the Nikon Software 
and you do not become the owner of it. Nikon retains ownership of Nikon Software and all copies of it and reserves all rights not expressively 
granted to you under this agreement. You only own the storage media on which the Nikon Software is recorded. This agreement constitutes the 
complete and exclusive agreement between you and Nikon and takes the place of any prior agreement, oral or written, between us relating to the 
Nikon Software. 
1. License: This license allows you to: 
A. Use the Nikon Software only on a single compatible personal computer. You must obtain a supplementary license from Nikon before using the 

Nikon Software in connection with systems, multiple central processing units, computer networks, or emulations on a main frame or mini comput­
er. 

B. Make one copy of the Nikon Software in machine-readable form solely for back-up purposes. The Nikon Software is protected by copyright law. 
You must reproduce on each copy the Nikon copyright notice and any other proprietary legends that were on the original copy. 

C Transfer the Nikon Software and all rights under this license to another party together with a copy of this Agreement provided you give Nikon 
written notice of conditions of this agreement. 

2. Restrictions 
Except as otherwise stated in this agreement, you may not make or distribute copies of the Nikon Software to others or electronically transfer the 
Nikon Software from one computer to another over a network. The Nikon Software contains trade secrets and in order to protect them, you may 
not decompile, reverse engineer, disassemble or otherwise reduce the Nikon Software to a human-perceivable form. YOU MAY NOT MODIFY, 
CHANGE, ADAPT, TRANSLATE, RENT, LEASE, LOAN, RESELL FOR PROFIT, DISTRIBUTE, NETWORK OR CREATE DERIVATIVE WORKS 
BASED UPON THE NIKON SOFTWARE OR ANY PART THEREOF. 
3. Term 
This license is effective until terminated. This license will terminate automatically without notice from Nikon if you fail to comply with any provisions 
of this license. Upon termination, you must destroy the Nikon Software and all copies thereof. You may terminate this license at any time by 
destroying the Nikon Software and all copies thereof. 
4. Foreign Export 
You agree and certify that neither the Nikon Software nor any related technical data is being or will be shipped, transferred, or re-exported directly 
or indirectly, into any country in any violation of any applicable export control laws, including, without limitation, the International Traffic In Arms 
Regulations and the Export Administration Act. 
5. LIMITED WARRANTY AND LIMITATIONS OF WARRANTY AND LIABILITY 
A. NIKON WARRANTS THAT THE STORAGE MEDIA ON WHICH THE NIKON SOFTWARE IS RECORDED IS FREE FROM DEFECTS IN MATE­

RIAL AND WORKMANSHIP UNDER NORMAL USE AND CONDITIONS FOR A PERIOD OF NINETY (90) DAYS FROM DATE OF DELIVERY 
TO THE ORIGINAL LICENSEE AS EVIDENCED BY THE ORIGINAL SHIPPING RECEIPT. DURING THIS PERIOD, IF THERE IS ANY 
DEFECT IN MATERIAL OR WORKMANSHIP TO THE STORAGE MEDIA, RETURN IT TO THE STORE (THE AUTHORIZED NIKON DEALER 
IN THE U.S.) WHERE YOU OBTAINED IT, TOGETHER WITH YOUR ORIGINAL SHIPPING RECEIPT, AND IT WILL BE REPAIRED OR 
REPLACED FREE OF CHARGE. 

B. THIS WARRANTY EXTENDS TO THE ORIGINAL LICENSEE ONLY AND IS NOT ASSIGNABLE OR TRANSFERABLE. THIS WARRANTY DOES 
NOT APPLY TO ANY STORAGE MEDIA WHICH HAS BEEN SUBJECT TO MISUSE, ABUSE, NEGLIGENCE OR ACCIDENT. ANY REPAIRED 
OR REPLACED STORAGE MEDIA SHALL BE WARRANTED FOR THE REMAINDER OF THE ORIGINAL LIMITED WARRANTY OR THIRTY 
(30) DAYS, WHICHEVER IS LONGER. ALL WARRANTIES IMPLIED BY LAW ON THE STORAGE MEDIA, INCLUDING BUT NOT LIMITED TO 
THE MERCHANT ABILITY OR FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED TO THE DURATION OF THE ABOVE WARRANTY. 
NIKON'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY HEREUNDER IS LIMITED SOLELY TO REPAIR OR REPLACEMENT OF THE 
STORAGE MEDIA ON WHICH THE NIKON SOFTWARE IS RECORDED. 

C EXCEPT FOR THE LIMITED WARRANTY FOR THE STORAGE MEDIA ON WHICH THE NIKON SOFTWARE IS RECORDED AS SET FORTH 
ABOVE, NIKON MAKES NO WARRANTIES, EITHER EXPRESSED OR IMPLIED. THE NIKON SOFTWARE IS PROVIDED "AS IS" WITHOUT 
ANY WARRANTY OF ANY KIND, AND NIKON, ITS EMPLOYEES, DISTRIBUTORS, DEALERS AND AGENTS SPECIFICALLY DISCLAIM ANY 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF MER­
CHANT ABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT DOES NIKON, ITS EMPLOYEES, DISTRIBUTORS, DEALERS 
OR AGENTS WARRANT THE PERFORMANCE OR THE RESULTS YOU MAY OBTAIN FROM THE NIKON SOFTWARE OR THAT THE NIKON 
SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE NIKON SOFTWARE WILL BE UNINTERRUPTED AND 
ERROR-FREE. IF THE NIKON SOFTWARE IS DEFECTIVE, YOU ASSUME ALL COSTS OF REPAIR OR SERVICING. IN NO EVENT SHALL 
NIKON, ITS EMPLOYEES, DISTRIBUTORS, DEALERS, OR AGENTS BE LIABLE TO YOU FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL 
OR INCIDENTAL DAMAGES, LOSSES, OR EXPENSES OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE LOSS OF PROFITS, BUSI­
NESS INFORMATION, OR BUSINESS INTERRUPTION ARISING OUT OF OR RESULTING FROM THE NIKON SOFTWARE HOWEVER 
CAUSED, EVEN IF NIKON HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, LOSSES, OR EXPENSES. 

D. EXCEPT AS OTHERWISE PROVIDED IN THIS AGREEMENT, NIKON SHALL HAVE NO LIABILITY OR RESPONSIBILITY OF ANY KIND 
(INCLUDING LIABILITY FOR NEGLIGENCE) TO YOU OR ANY OTHER PERSON OR ENTITY WITH RESPECT TO ANY LIABILITY, LOSS OR 
DAMAGE CAUSED OR ALLEGED TO HAVE BEEN CAUSED, DIRECTLY OR INDIRECTLY BY THE NIKON SOFTWARE SOLD, LICENSED, OR 
FURNISHED BY NIKON UNDER THIS AGREEMENT, NOTWITHSTANDING THE ABOVE LIMITATION, NIKON'S LIABILITY OF ANY CLAIM OF 
ANY KIND (INCLUDING NEGLIGENCE) FROM THE DELIVERY, LICENSE, OR USE OF THE NIKON SOFTWARE FURNISHED UNDER THIS 
AGREEMENT SHALL IN NO CASE EXCEED THE FEE YOU PAID FOR THE NIKON SOFTWARE. 
SOME JURISDICTIONS DO NOT ALLOW (A) LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS OR (B) THE EXCLUSION OR 
LIMITATIONS OF INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO 
YOU. NIKON'S WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM 
JURISDICTION TO JURISDICTION. 
NIKON'S WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY LOCAL 
LAWS. 

6. General 
If any provision of this agreement shall be determined to be invalid for any reason, the remaining provisions shall not be invalidated and shall remain 
in full force and effect. 



Technical Support 
Nikon strives to produce high quality software that is simple to install and operate. If you encounter a 

problem installing or operating this software package, please take the following steps before contacting technical 
support. 

If you are unable to establish communication with your camera through the serial link, check the status of 
your communication ports in the Windows® Device Manager. You can open the Device Manager by going to the 
Control Panels Folder and Double Clicking on the "System" Icon. Find the "Ports" icon in the list of devices and 
click on the "+" sign just to the left of the "Ports" Icon. 

Your system may have only one or two Com ports shown. If Com 1 or Com 2 have a red "X" or a yellow 
" I " attached, this indicates a system conflict is present. Click on the port icon that shows a conflict and then click 
"Remove" at the bottom of the System Properties dialog. Shut the system down via the START menu and then 
restart. Windows® will attempt to reinstall the ports using the default values. If the ports still show any conflict after 
reinstallation, please contact your system vendor for assistance. 

If your Ports appear to be operating properly (no conflicts shown) and you still cannot establish communi­
cation with your camera, double click on each Com port in turn and check the settings located under the 
"Resources" tab. The ports should be at the expected default settings. 

The default setting for Communication ports One and Two: 

Com Port IRQ I/O range 
1 4 03F8-03FF 
2 3 02F8-02FF 

If your ports are not set to these parameters, Photo Secretary may not be able to establish communica­
tion with your camera. Please make the appropriate adjustments to the port settings, then restart your PC. 

Please note that if your system supports Com Ports 3 and 4, devices attached to these ports will cause a 
conflict with Com Ports 1 and 2 if you attempt to use the devices simultaneously. If you have a serial mouse 
installed at Com 1 and an internal modem installed at Com 2, you will not be able to use Photo Secretary on Com 
3 in any case, or on Com 4 while the modem is in use. 

If your system supports two physical serial ports, the port assignments have Com 1 and Com 3 sharing 
the same physical connection. Com 2 and Com 4 also share the same physical serial port. While an internal 
modem will not share the same physical connection, the same principle applies. If your modem is set to Com 2, 
while it is in use Com 4 devices cannot be used. 

If you have a fax modem or Windows® CE device ( PDA) installed on your system, this may prevent 
Photo Secretary from communicating with your camera. Please refer to your third party device documentation in 
order to free a Com port for use by Photo Secretary. 

Some new PC's ship with the COM ports switched off in the system BIOS. This is most common in lap­
tops with built in modems. Please check your system documentation in order to change the BIOS settings, or con­
tact your PC supplier if you are still unable to establish communication with your camera. 

If you are unable to resolve a problem, please contact the Nikon Service facility located in your area. Please print a 
system summary from the device manager before placing the call, as the support engineer will require information 
from this report in order to assist you. 

All printed material and electronic files provided are protected by Copyright. None of the supplied materials may be 
reproduced in any form without the expressed written permission of Nikon Corporation. 

© Nikon Corporation, 1995-1999 (Photo Secretary II for F100) 
© Nikon Corporation, 1997 (Photo Secretary for F5) 
© Nikon Corporation, 1995-1996 (Photo Secretary for F90X/F90) 
Windows is a registered trademark of the Microsoft Corporation in the United States and / or other countries. 
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Type EC-E Focusing Screen (for F5) 
Thank you for purchasing the type EC-E 
focusing screen. The EC-E is a matte field 
focusing screen with etched horizontal and 
vertical lines added to a type EC-B focusing 
screen to aid you when composing a picture. 
Five focus brackets are provided and selected 
focus brackets are displayed darker for easy 
confirmation. In combination with various 
lenses, the EC-E screen has the same focusing 
status and required degree of exposure 
compensation as the EC-B focusing screen. 

EC-E Einstellscheibe fur F5 
Die Ausstattung dieser Mattfeld Einstellscheibe 
entspricht der EC-B Scheibe. Dariiberhinaus 
bietet sie zur besseren Motivgestaltung 
horizontale und vertikale Linien. Die funf 
zusatzlichen Fokussierfelder erleichtern das 
Fotografieren bei AF Betrieb. Das jeweils 
angewahlte AF Feld erscheint dunkler als die 
anderen, dadurch wird leicht erkennbar, in 
welchem Motivbereich der Autofokus aktiv ist. 
Die fur verschiedene Objektive erforderliche 
Belichtungskorrektur ist mit der Einstellscheibe 
EC-B identisch. 

Verre de visee de type EC-E 
(pour F5) 

Merci d'avoir porte votre choix sur le verre de 
visee EC-E. Le EC-E est un verre de visee a 
depoli et lignes horizontales et verticales 
gravees ajoutes a un verre de visee de type 
EC-B pour vous aider a composer I'image. 
Cinq reperes de mise au point sont prevus et 
les reperes selectionnes sont assombris pour 
faciliter la confirmation. Combine a differents 
objectifs, le verre EC-E a le meme statut de 
mise au point et degre requis de compensation 
d'exposition que le verre de visee EC-B. 



Nikon 
Pantalla de enfoque de tipo EC-E 

(para F5) 
Muchas gracias por su compra de la pantalla 
de enfoque de tipo EC-E. La EC-E es una 
pantalla de enfoque con un campo mate con 
lineas horizontales y verticales grabadas, 
agregadas a una pantalla de enfoque de tipo 
EC-B para ayudarle a componer una imagen. 
Hay cinco niveles de enfoque y los niveles de 
enfoque seleccionados aparecen mas 
oscuros para confirmarlos facilmente. En 
combinacion con distintos objetivos, la 
pantalla EC-E tiene el mismo estado de 
enfoque y el grado de compensacion de 
exposicion necesario que la pantalla de 
enfoque EC-B. 
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Nikon 
Ocutare del Mirino Antiappannamento DK-14/DK-15 

Vi ringraziamo per aver acquistato I'Oculare del Mirino Antiappannamento. Questo 
mirino possiede una piastra di plastica trasparente con un rivestimento speciale della 
superficie che riduce I'appannamento dell'oculare. 
L'appannamento pub essere ridotto nei casi seguenti: 
• A basse temperature, quando il mirino si appanna a causa della condensazione del 

respiro del fotografo o per altri motivi. 
• Ad alte temperature ed in luoghi molto umidi, quando il mirino si appanna a causa di 

vapori provenienti dal sudore del fotografo o per altri motivi. 

Per mantenere I'efficacia di questo prodotto, assicuratevi di seguire attentamente le 
note di cui sotto. L'utilizzo dell'oculare in casi al di fuori di quelli descritti nelle note 
di cui sotto, pud essere causa di guasti. 

Macchine fotografiche utilizzabili 

DK-14: F5, F4-series, F3HP, F3T, F3P 
DK-15: F100, F90X, F90-series, F-801s, F-801, D1 

Fissaggio dell'Oculare del Mirino Antiappannamento 
1. Staccare I'oculare in dotazione dal corpo principale della macchina fotografica. 
2. Fissare I'Oculare del Mirino Antiappannamento avvitandolo saldamente, nella stessa 

maniera in cui era stato avvitato I'oculare in dotazione. 
• In alcuni casi, I'immagine pub apparire leggermente confusa, ma cio non ha 

ripercussioni sulla qualita finale dell'immaginefotografata. 

Note 
• Non toccare la piastra di plastica trasparente dell'oculare direttamente con le vostre dita. 
• Fare attenzione affinche neve o pioggia non venga a contatto diretto con la piastra di 

plastica. 
• Utilizzare una spazzola a soffio per rimuovere polvere, gocce d'acqua o neve dalla 

piastra di plastica. Se vi e un residuo di umidita sulla piastra di plastica, asciugare tale 
residuo con un fazzoletto di carta. In tal caso, fare attenzione affinche il fazzoletto non 
venga a contatto con la piastra di plastica. 

• Se la piastra di plastica viene macchiata da impronte digitali o appannata da 
eccessiva umidita atmosferica, pulirla leggermente con un panno di pelle 
scamosciata. Fare attenzione a non strofinare fortemente la piastra di plastica in 
quanto cio potrebbe graffiarne la superficie. 

• L'effetto antiappannamento non diminuisce con il tempo, ma I'immagine del mirino 
pub deteriorarsi in qualita, se la piastra di plastica viene graffiata. 

• L'oculare puo deformarsi se lasciato in luoghi a temperature estrememente alte; per 
esempio vicino a riscaldatori d'aria o in una macchina sotto la luce solare diretta. 

• In caso di temperature eccessivamente alte o umidita eccessiva, l'appannamento 
dell'oculare non puo essere prevenuto completamente. 

• Se una smacchiatura sulla piastra di plastica non pub essere rimossa strofinandoci 
sopra, pulirla facendo attenzione ai punti seguenti: 
* Pulire l'oculare gentilmente, usando un panno soffice ed uno smacchiatore per obiettivi. 
* Non asciugare l'oculare usando fonti di calore quali il fon. 
* Lo strofinamento della piastra di plastica pub occasionamlmente essere causa di 

deterioramento nell'efficacia dell'effetto antiappannamento. 
• Le smacchiature sulla piastra di plastica non hanno effetto sull'efficacia della capacita 

antiappannamento deH'oculare. 



Nikon 
Lentilla anti-vaho DK-14/DK-15 

Muchas gracias por su compra del ocular del visor antiniebla de Nikon. Este ocular tiene 
una placa de plastico transparente con un revestimiento de superficie especial que 
reduce la niebla en el ocular. 
Se puede reducir la niebla bajo las siguientes condiciones: 
• A bajas temperaturas, cuando hay niebla en el visor por la condensation de la 

respiracibn del fotografo, u otras causas. 
• A altas temperaturas y humedad, cuando hay niebla en el visor por el vapor de la 

transpiration del fotografo u otras causas. 

Para mantener este producto en condiciones efectivas, respete las notas que se dan 
a continuacibn. El uso del ocular de formas no descritas en estas notas puede 
danarlo. 

Camaras en las que puede utilizar 

DK-14: F5, serie F4, F3HP, F3T, F3P 
DK-15: F100, F90X/N90S*, serie F9O/N90*, F-801s/N8008s*, F-801/N8008*, D1 
• Las Nikon N90s, N90, N8008s y N8008 se vende exclusivamente en el mercado de EEMU. 

Instalacion del ocular del visor antiniebla 
1. Desmonte el ocular suministrado con el cuerpo de la camara. 
2. Instate el ocular del visor antiniebla enroscando firmemente, de la misma forma que 

el ocular suministrado. 
• Bajo determinadas circunstancias, puede aparecer una imagen borrosa pero esto no 

afectara la imagen real. 

Notas 
• No toque la placa de plastico transparente del ocular con sus dedos. 
• Tenga cuidado de no permitir que la nieve o las gotas de lluvia caigan directamente 

sobre la placa de plastico. 
• Utilice un cepillo con soplador para limpiar el polvo, gotas de lluvia o nieve de la placa 

de plastico. Si queda humedad en la placa de plastico, seque, tocando y empapando 
la humedad con un pedazo de papel tisii. No frote la placa de plastico para secarlo. 

• Si la placa de plastico tiene manchas de huellas dactilares o hay niebla debido a la 
existencia de gran humedad, frote suavemente con un pano suave como de gamuza. 
Frote suavemente ya que si lo hace con fuerza, la superficie de la placa de plastico 
puede tener rayas. 

• El efecto de antiniebla no desaparece con el tiempo pero la imagen del visor puede 
verse peor si la placa de plastico esta rayada. 

• El ocupar puede deformarse si lo deja expuesto a temperaturas muy altas, por ejemplo 
cerca de la calefaccion o en el interior de un coche bajo los rayos directos del sol. 

• Cuando se expone a extremos de temperatura o gran humedad, puede no eliminarse 
completamente la niebla. 

• Si no puede limpiar las manchas en la placa de plastico aunque lo frote, limpie 
teniendo en cuenta los siguientes puntos: 
* Frote suavemente el ocular con un paho suave limpio y un limpiador de lentes. 
* No seque el ocular con calor, por ejemplo un secador de cabellos. 
* Tenga en cuenta que cuando se frota la placa de plastico, a veces puede deteriorar 

el efecto antiniebla. 
• Las manchas en la placa de plastico no afectan la capacidad antiniebla del ocular. 



Nikon 
Antifog Finder Eyepiece DK-14/DK-15 

Thank you for purchasing the Nikon Antifog Finder Eyepiece. This eyepiece features a 
transparent plastic plate with a special surface coating which reduces fogging on the 
eyepiece. 
Fogging can be reduced under the following conditions: 
• In low temperatures, when the finder becomes foggy due to condensation from the 

photographer's breath or other causes. 
• In high temperatures and humidity, when the finder becomes foggy due to steam from 

the photographer's perspiration or other causes. 

To maintain the effectiveness of this product, be sure to follow the notes below. Use 
of the eyepiece in any way not described in these notes may cause damage. 

Usable Cameras 

DK-14: F5, F4-series, F3HP, F3T, F3P 
DK-15: F100, F90X/N90S*, F90-series/N90*, F-801 s/N8008s*, F-801/N8008*, D1 
• The Nikon N90s, N90, N8008S, N8008 are sold exclusively in the U.S.A. 

Attaching Antifog Finder Eyepiece 
1. Detach the supplied eyepiece from the camera body. 
2. Attach the Antifog Finder Eyepiece by screwing it in firmly, in the same way as the 

supplied eyepiece. 
• Under some circumstances, image blur may occur but it does not affect the actual 

picture image. 

Notes 
• Do not touch the transparent plastic plate of the eyepiece with your fingers. 
• Be careful not to let snow or raindrops fall directly onto the plastic plate. 
• Use a blower brush to clean any dust, raindrops or snow from the plastic plate. If 

moisture remains on the plastic plate, dry it by touching the moisture with a piece of 
tissue. When doing so, make sure not to wipe the plastic plate. 

• If the plastic plate becomes stained with fingerprints or fogged from very high 
humidity, wipe it gently with a soft cloth such as chamois. Make sure you wipe it 
gently as strongly wiping the plastic plate may cause scratches on the surface. 

• The anti-fogging effect does not deteriorate but the finder image somewhat 
deteriorates if the plastic plate becomes scratched. 

• The eyepiece may become deformed if it is left in extremely high temperatures such 
as near a heater or inside a car in direct sunlight. 

• In extreme temperatures or very high humidity, fogging may not be prevented 
completely. 

• If a stain on the plastic plate cannot be removed by wiping, clean it noting the 
following points: 
* Wipe the eyepiece gently using a clean soft cloth and a lens cleaner. 
* Do not dry the eyepiece using heat, such as with a hairdryer. 
* Note that wiping the plastic plate occasionally may cause the anti-fogging effect to 

deteriorate. 
• Stains on the plastic plate do not affect the anti-fogging capability of the eyepiece. 



Nikon 
Beschlagfreies Sucherokular DK-14/DK-15 

Durch die Verwendung eines speziell beschichteten Kunststoffs wird bei diesen 
Sucherokularen das Beschlagen reduziert. 
Unter folgenden Bedingungen kommt dieser wichtige Vorteil zum Tragen: 
• Bei niedrigen Temperaturen, wenn ein herkbmmliches Okular durcb den Atem des 

Fotografen beschlagt und bei hohen Temperaturen und hoher Luftfeuchtigkeit. 

Bitte lesen diese Anleitung, damit Sie das Okular optimal nutzen kbnnen. Bitte 
beachten Sie die Reinigungshinweise. 

Geeignete Kameras: 

DK-14: F5, F4 Serie, F3HP, F3T, F3P 
DK-15: F100, F90X, F90 Serie, F-801S, F-801, D1 

Anbringen des Sucherokulars 

Entfernen Sie bitte das mitgelieferte Okular von der Kamera und scbrauben Sie das 
Anti-Beschlag Okular sicher ein. 
• Unter bestimmten Voraussetzungen kann das Sucherbild unscharf erscheinen; dies 

hat jedoch keine Auswirkung auf die Aufnahme. 

Wichtige Hinweise 

• Beriihren Sie nicht die transparente Oberflache des Okulars. 
• Vermeiden Sie mbglichst Nasse auf dem Okular. 
• Zum Reinigen gehen Sie bitte wie folgt vor: 

Entfernen Sie Staub mit einem Blasepinsel und entfernen Sie Nasse durch Tupfen mit 
einem weichen sauberen Tuch. Bitte gehen Sie behutsam vor, urn die Oberflache nicht 
zu beschadigen. 

• Wischen Sie bitte Fingerabdriicke und anderen Belag ebenfalls mit einem weichen 
und sauberen Tuch ab. Vermeiden Sie dabei starken Druck, der zu Kratzern fiihren 
kann. 

• Bei Kratzern verschlechtert sich zwar das Sucherbild, die Antibeschlagwirkung bleibt 
aber erhalten. 

• Schiitzen Sie das Okular bitte vor zu hoher Temperatur. Denken Sie auch daran, daB 
Temperaturen in einem in der Sonne abgestellten Fahrzeug besonders stark ansteigen 
konnen. 

• Bei sehr hohen Temperaturen und sehr hoher Luftfeuchtigkeit ist keine vollstandige 
Antibeschlagwirkung moglich. 

• Besonders hartnackige Verschmutzungen beseitigen Sie bitte wie folgt: 
* Reinigen Sie das Okular vorsichtig mit einem sauberen weichen Tuch und 

Linsenreiniger, 
* Lassen Sie das Okular an der Luft trocknen. Auf keinen Fall einen Haartrockner zum 

Trocknen benutzen. 
* Zu haufiges Reinigen kann die Antibeschlagwirkung einschranken. 

• Verschnutzungen auf der Kunststoffplatte haben keinen Effekt auf die 
Antibeschlagwirkung. 

Printed in Japan K9F1200101 (K638) 60 



Nikon 
Verre protecteur d'oculaire antibuee 

DK-14/DK-15 
Merci d'avoir porte votre choix sur I'oculaire de viseur anti-voile Nikon. Cet oculaire se 
presente sous forme de plaque en plastique transparent, a revetement de surface 
special reduisant le voile de I'oculaire. 
Le voile peut etre reduit dans les conditions suivantes: 
• A basses temperatures, quand le viseur est voile a cause de la condensation due a la 

respiration du photographe ou a d'autres causes. 
• A hautes temperature et humidite, quand le viseur est voile par la vapeur due a la 

respiration du photographe ou a d'autres causes. 

Pour maintenir I'efficacite de ce produit, respectez les notes ci-dessous. L'emploi de 
I'oculaire de toute autre maniere risquerait de I'endommager. 

Appareils sur lequel il est utilisable 
DK-14: F5, serie F4, F3HP, F3T, F3P 
DK-15: F100, F90X, serie F90, F-801S, F-801, D1 

Fixation de I'oculaire de viseur anti-voile 
1. Retirez I'oculaire fourni avec I'appareil. 
2. Montez I'oculaire de viseur anti-voile en le vissant fermement, comme I'oculaire 

fourni. 
• L'image peut parfois etre floue, mais cela n'affecte pas I'image reelle. 

Remarques 
• Ne touchez pas la plaque en plastique transparent de I'oculaire avec les doigts. 
• Evitez le contact direct de la plaque en plastique avec la neige ou la pluie. 
• Utilisez une poire soufflante pour eliminer la poussiere, les gouttes de pluie ou la 

neige de la plaque en plastique. Si de I'humidite reste dessus, eliminez-la 
completement en appuyant un chiffon contre la plaque, mais sans I'essuyer. 

• Si la plaque en plastique est tachee par des traces de doigt ou voilee par une tres 
forte humidite, essuyez-la doucement avec un chiffon doux, du chamois par exemple. 
Essuyez doucement, sinon la surface de la plaque pourrait etre rayee. 

• L'effet anti-voile ne se deteriore pas, mais I'image du viseur peut etre legerement 
deterioree si la plaque en plastique est rayee. 

• L'oculaire peut etre deforme s'il est laisse a temperature tres elevee, pres d'un 
appareil de chauffage ou dans une voiture en plein soleil par exemple. 

• A temperatures extremes ou a tres forte humidite, le voilage peut ne pas etre 
entierementevite. 

• Si les taches sur la plaque en plastique ne peuvent pas etre eliminees en les essuyant, 
nettoyez en notant les points suivants: 
* Essuyez doucement I'oculaire avec un chiffon doux propre et du produit de 

nettoyage pour lentille. 
* Ne sechez pas I'oculaire a la chaleur, avec un sechoir a cheveux par exemple. 
* Notez qu'essuyer la plaque en plastique de temps a autre peut deteriorer l'effet 

anti-voile. 
• Les taches sur la plaque en plastique n'affectent pas la capacite anti-voile de 

I'oculaire. 
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Dear Nikon Customer: 
Please take a moment to complete the following information and mail immediately. This will register your 
Nikon Photo Secretary software and will allow us to contact you with any future announcements. 

Thank you. 
Nikon Corporation 

Name: 

Address: 

City: Country: Postal code: 

Telephone #: 

Cameras Owned: 

Photo Status: Pro: Advanced: Amateur: Beginner: 

Product name: (please tick the one you have) 

Photo Secretary for • F5 for Windows® 

Photo Secretary for • F5 for Macintosh® 

Photo Secretary II for • F100 for Windows® 

Photo Secretary for • F90X/F90 for Windows® 

Serial #: O Z D u H l Z O Z D (indicated on one of the enclosed floppy disks or the CD-ROM case) 

Version #: (included in Help menu) 

M a c : P C : Windows® is a registered trademark of Microsoft Corporation, USA. 
Macintosh® is a registered trademark of Apple Computer Inc., USA. 



FOREWORD 
Thank you for purchasing Nikon Photo Secretary II for F100 (AC-2WE). This software 
is easy to use, but requires familiarity with basic Windows® operations and functions, 
including: handling of folders, windows, menus, the clipboard, and general mouse and 
keyboard techniques. If you are not familiar with these operations, please refer to your 
"Microsoft Windows Help". 

Nikon Photo Secretary II is programmed to allow you to: 
• Design customized settings on the F100 camera. 
• Download shooting data directly from the F100, F90/F90X (N90/N90s) or F5 cam­

era to your personal computer. 
• Edit shooting data downloaded from the camera to a personal computer, and link it 

to image data loaded from a scanner or Photo CD. 
• Use the extensive on-line help system. 

* Microsoft, Windows and Windows NT are registered trademarks or trademarks of 
Microsoft Corporation in the USA and/or other countries. 

* Photo CD is a registered trademark of Eastman Kodak Company. 
* Nikon Corporation holds the copyrights of all sample image data appearing in this 

software. 
* All other trademarks are the property of their respective owners. 

Paste the provided serial 
number seal here. 
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FOREWORD 
Configurations 
Make sure the following items are provided: 
• One CD-ROM with installer 
• Instruction manual 
• Registration card 
• License agreement 
• One serial number seal; paste it on page 3 of this manual. 

System Requirements for Installing Nikon Photo Secretary I I 
Minimum PC System Requirements 
To use Photo Secretary II, your computer system must be equipped with the follow­
ing peripheral equipment and software: 

Hardware: 
• Personal computer compatible with Microsoft Windows® 95, Windows® 98, 

Windows NT® Workstation 
• 16 MB or more memory for Windows® 95/98 (32 MB or more recommended for 

optimum performance); 24 MB or more memory for Windows NT® (48 MB or more 
recommended for optimum performance) 

• 10 MB or more free memory (100 MB or more recommended for optimum perfor­
mance) on the hard disk 

• CD-ROM drive (for installation) 
• Available external RS-232C serial port (COM1 -COM4) 
• Nikon Personal Computer Connecting Cord MC-33 or MC-31 (optional) 

• The MC-33 is for 9-pin serial port (Dsub-9); the MC-31 for 25-pin serial port 
(Dsub-25). 

• The MC-33 or MC-31 is always required to connect the F100 camera to a 
personal computer. 

• To connect the F90/F90X (N90/N90s) camera to a personal computer, use 
the MC-31. 

• To connect the F5 camera to a personal computer, use the MC-33. 
• If the MC-33 or MC-31 does not match your computer's RS-232C serial port, 

use the appropriate optional serial port convertible adapter. 

Software: 
• Microsoft Windows® 95, Windows® 98, or Windows NT® Workstation 4.0. 

4 



WELCOME TO NIKON PHOTO SECRETARY I I 
Before Installing Photo Secretary I I on Your Personal Computer 
Check the distribution CD-ROM for any late-breaking news or additions to this 
instruction manual. If it contains updated information or corrections, the information 
will appear in a file named "readme.txt". The readme.txt file is an ASCII text file that 
can be read using WordPad (select File Type ".tort" in WordPad) or Notepad. 
Information in this file, will supersede or correct information contained in this instruc­
tion manual. 

Installing Nikon Photo Secretary I I 
1. With the desktop of Windows® 95, Windows®98 or Windows NT® Workstation 4.0 

displayed, insert the CD-ROM in the CD-ROM drive. 
2. With the Auto Run function, installation will automatically start. (Fig. 1) 

Pf f f f l 

Photo Secretary II for F100 Setup is preparing the 
Installshield® Wizard which will guide you through the rest 

"^ of the setup process. Please wait 

(Fig. D 

If installation does not start, choose "Run" from the Start menu, specify file name 
("G:¥Setup.exe" is specified in the example with the Drive G as the CD-ROM 
drive), then click "OK". (Fig. 2) 

jp 
flpen: 

Type the name of a program, folder, document, or Internet 
resource, and Windows will open it for you. 

|GASetupexe! _~j 

OK j Cancel j growse... j 

(Fig. 2) 

Installation will start. 
• With Windows NT® Workstation 4.0, only users in the Administrator Group can 
install this software. For details about user groups, see the instruction manual of 
Windows NT® Workstation 4.0. 

!) 



3. The Choose Destination Location dialog box lets you select the folder where Photo 
Secretary II will be installed. If you want to change the folder, click "Browse" and 
select the desired folder. Follow the instructions on your screen. Click "Next" to 
continue the setup process. 

E=32 as M>\ 

To install to (his folder, dick Next. 

To install to a different folder, click Browse and ssfeet another 
folder. 

You can choose not to install Photo Secretary II tor F100 by 
clicking Cancel to exit Setuo. 

fj.>:tiriatiQnFokter- •• 

j C.V. \NikwAPboto Seeretsti* 2 

(Fig. 3) 

4. The Setup Type dialog box lets you select "Program and sample" or "Program 
only", then click "Next". 
• You need 40 MB or more free memory on your hard disk for "Program and 

sample" or 10 MB or more free memory for "Program only". 

Qick the type of Setup you ptetet. then cfick Next 

)llll I II • • • — 

Description 

Itislafl program files and sample files 

(Fig. 4) 

file:///NikwAPboto


5. Select the program folder on the Select Program Folder dialog box (Fig. 5). Click 
"Next" to start copying files. When all necessary files have been copied, the Setup 
Complete dialog box will be displayed. Click "Finish" to complete the setup 
process. 
• If you have updated the system file, you may have to restart the system. 

(Rg. 5) 
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Deleting Nikon Photo Secretary II from Your Personal Computer 

1. From the Start menu, select "Settings", then "Control Panel" to display the control 
panel. 

2. Double-click the "Add/Remove Program" icon to activate the Add/Remove 
Program Properties dialog box. (Fig. 6) 

3. On the dialog box, select "Nikon Photo Secretary II for F100" and click 
"Add/Remove Program" to activate the Confirm File Deletion message box. Click 
"Yes". 

4. Nikon Photo Secretary is then deleted from your personal computer. The Remove 
Program dialog box indicates that deleting is in progress. After deleting is complet­
ed, click "OK". 

EBBmsmamaammmmMi 
InstalVUnirotall | Windows Setup | Startup Disk ( 

To install a new program from a floppy disk or CD-ROM 
drive, click Install. 

-' '"l l ^ e following software can be automatically removed by 
'.J I Windows. To remove a program or to modify its installed 

" ^ components, select it from the list and click 
Add/Remove. 

Add/R amove. i-in.. 

Cancel 

(Fig. 6) 

A confirmation message box may ask you whether a share file (i.e., a file that may 
be used for Photo Secretary II and another maker's application program) can be 
deleted or not. Be careful when deleting a share file as doing so may affect other 
application programs. 



Contents of Photo Secretary I I 

Nikon Photo Secretary II for F100 contains the following applications (Fig. 7): 
• Photo Secretary 

This is the main application of Nikon Photo Secretary II for F100. This manual uses 
the term "Photo Secretary" for this application. Photo Secretary lets you download 
shooting data from the camera to a personal computer, select Custom Settings 
options, and edit shooting data. 
Used with Photo Finder, an image loading application, Photo Finder allows you to 
link the image data with the shooting data. 

• Photo Finder 
This is the image data loading application of Nikon Photo Secretary II for F100. 
Photo Finder can be started up independently. However, in most cases, it is acti­
vated via Photo Secretary. Photo Finder allows you to load image data from a 
scanner or other equipment, or photo CD. The loaded image data can be edited 
and saved as files. ("Image List" and "Load Multiple Images" commands are avail­
able in Photo Secretary.) 
Photo Finder is started via the Photo Secretary when shooting data is linked to the 
image data. It sends information about the image to the Photo Secretary. 

• Nikon Photo Secretary I I for F100 Help 
Shows instructions for using Photo Secretary II for F100, including basic opera­
tions. 

• "readme" File 
If the provided CD-ROM contains updated information or corrections, the informa­
tion will appear in the readme file. The readme file can be read using WordPad 
(select File Type ".txt" in WordPad) or Notepad. 

(Fig. 7) 



Selecting a Communication Port 
Select the RS-232C serial port to which you will connect the Personal Computer 
Connecting Cord MC-33 or MC-31. 

1. Start the Photo Secretary application in Photo Secretary II for F100. 
2. Click "Tool" and "Configuration". 
3. Select the port to which you intend to connect the cord. 

Photo Secretary supports COM1, COM2, COM3 and COM4 ports. Select a free COM 
port supported by your computer. If you are using an internal modem on COM1, then 
your serial port will be COM2, COM3 or COM4. 
Fig. 8 shows Configuration dialog box. 
• To confirm a free port, refer to your computer's instruction manual. 

Common j Text/Film v 

Default mm style 

Delault number of frames 

Toolbar 

f* Small Toolbar 

r~ Large Toolbar 

Unit 
C Inch 

t*" mm 

Separation characters Communication Port SecondVmmute display 
ff [Tab) [ com ^ i " ("•• 

r 0 
r I I 

(Fig. 8) 
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Connecting the Camera to a Personal Computer with the F100 
To connect the Nikon F100 camera to your personal computer, use only Nikon 
Personal Computer Connecting Cord MC-33 or MC-31. A data link cannot be estab­
lished with any other connecting cord. 

Connecting 
1 . Turn off both the camera and personal computer. 
2. Connect the MC-33 or MC-31 to the camera's 

10-pin remote terminal. 
Insert the cord's plug into the terminal with the 
"A" symbol pointing to the dot at the upper left 
of the terminal, then turn the lock screw as far as 
it will go. (Fig. 9) 

3. Connect the MC-33 or MC-31 to the personal 
computer's RS-232C serial port. 
Match the shape of the cord's connector with 
the personal computer's terminal, then push it in 
and tighten the two screws on the plug. 

4. Turn the computer on, start Windows®, then 
turn the camera on. 

Disconnecting 
1 . Guit Windows®, then turn off both the camera 

and personal computer. 
2. Remove the cord's connector from the personal 

computer. 
Loosen the two screws on the connector, then 
pull it out. 

3. Remove the cord's plug from the camera body. 
Unscrew the lock ring, then unplug the cord. 
(Fig. 10) 

(Fig. 10) 
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Connecting the Camera to a Personal Computer with the F5 
To connect the Nikon F5 camera to your personal computer, use only Nikon Personal 
Computer Connecting Cord MC-33. A data link cannot be established with any other 
connecting cord. 

Connecting 
1 . Turn off both the camera and personal computer. 
2. Connect the MC-33 to the camera's 10-pin 

remote terminal. 
Insert the cord's plug into the terminal with the 
"A" symbol pointing to the right, then turn the 
lock screw as far as it will go. (Fig. 11) 

3. Connect the MC-33 to the personal computer's 
RS-232C serial port. 
Match the shape of the cord's connector with 
the personal computer's terminal, then push it in 
and tighten the two screws on the plug. 

4. Turn the computer on, start Windows®, then 
turn the camera on. 

Disconnecting 
1 . Quit Windows®, then switch off both the camera 

and personal computer. 
2. Remove the cord's connector from the personal 

computer. 
Loosen the two screws on the connector, then 
pull it out. 

3. Remove the cord's plug from the camera body. 
Unscrew the lock ring, then unplug the cord. 
(Fig. 12) 

(Fig. 12) 

(Fig. 11 
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(Fig. 13) 

Connecting the Camera to a Personal Computer 
with the F90/F90X (N90/N90s) 
To connect the Nikon F90/F90X (N90/N90s) camera to your personal computer, you 
must use Nikon Personal Computer Connecting Cord MC-31. You cannot establish a 
data link with any other connecting cord. 

Connecting 
1 . Turn the camera and personal computer off. 
2. Connect the MC-31 to the camera's 10-pin 

remote terminal. 
Insert the cord's plug into the terminal with the 
"A" symbol pointing up, then turn the lock screw 
as far as it will go. (Fig. 13) 

3. Connect the MC-31 to the personal computer's 
RS-232C serial port. 
Match the shape of the cord's connector with 
the personal computer's terminal, then push it in 
and tighten the two screws on the plug. 

4. Turn the computer on, start Windows®, then 
turn the camera on. 

YV\\\IV'J ®1 
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i 

Disconnecting 
1 . Quit Windows®, then switch off both camera 

and personal computer. 
2. Remove the cord's connector from the personal 

computer. 
Loosen the two screws on the connector, then 
pull it out. 

3. Remove the cord's plug from the camera body. 
Unscrew the lock ring, then unplug the cord. 
(Fig. 14) 

(Fig. 14) 
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Photo Secretary II Functions 

All functions can be accessed via pull-down menus. The Menu Bar and menu 
options will change to match the active operation. Unavailable functions will appear 
"dimmed" or not at all. Most functions can also be accessed via the Toolbar but­
tons. 
Most menu commands, options and functions can be found with the Help function 
(Fig. 15) 

Toolbar icons 
Holding the cursor over an icon causes a "Tool Tip" 
to appear.Click the *P toolbar icon, then click on 
the icon for which you would like help. 
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Toolbar Icons 

Toolbar icons in Photo Secretary main window 
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Using the "One Point" Function 
For the factory-set default setting, Photo Secretary displays a One Point window after 
startup. This window shows a brief explanation of Photo Secretary operations and 
functions. Clicking the "Next" button displays the explanation for the next topic. When 
the "Show at startup" box is checked, the One Point window is always displayed 
when Photo Secretary is started. To cancel the One Point window, uncheck the 
"Show at startup" box, quit the application and restart. To display the One Point win­
dow again, select "Help" then click "One Point". 
• With the One Point window displayed, you cannot operate Photo Secretary on the 

other windows. For other window operations, close the One Point window. 

Using the Guide Window 
The guide window shows brief instructions with icons on how to operate Photo 
Secretary correctly. 
1. From the Start menu, click [Programs]-[IMikon Photo Secretary II for F100]-[Photo 

Secretary] to start the Photo Secretary application. 
2. To display the Guide window, click [View]-[Guide] so that a check mark is shown 

at the left side of the "Guide" command. 
3. Clicking the icons on the Guide window activate the window for corresponding 

functions. 
4. To hide the Guide window, click [View]-[Guide] so that a check mark beside the 

"Guide" command disappears. 
• Use the "Help" function to see how to operate or use the activated window. 

Using the "Help" Function 
To open Photo Secretary II Help, select "Programs" from the Start menu, select 
"Nikon Photo Secretary II for F100" then click "Photo Secretary II for F100 Help". 
Photo Secretary II Help shows you the basic operations of Nikon Photo Secretary II 
for F100. The Help menu offers the help commands shown below. To see a help 
message while the Photo Secretary is running, press the F1 key. 

The Help menu offers: 
• Help Topics 

• Contents: Displays contents of "Help". 
• Index: Searches information by category. 
• Find: Finds items for which you want to see help messages (based on keywords 

you specify). 
• About Photo Secretary 

Displays the version number of your Photo Secretary application. 
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STARTING AND USING PHOTO SECRETARY 

Photo Secretary allows you to select Custom Settings options, download shooting 
data from the camera, and edit shooting data. 
To start Photo Secretary, select "Programs" from the start menu, and click "Nikon 
Photo Secretary II for F100" then "Photo Secretary". (Fig. 16) 

File Miew I01** Help 

For Help, press FT 

(Fig. 16) 
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Configuration 
With the Configuration dialog box, you can set default settings for Photo Secretary oper­
ation. Configuration options can be set with the connected camera body turned off. 

1. Start the Photo Secretary application of Photo Secretary II for F100. 
2. Click "Tool" and "Configuration" to activate the Configuration dialog box. (Fig. 17) 
3. Select Configuration options as desired, then click "OK" to close the dialog box 

with the settings updated. 

Configuration 

Common j Text/Film view j Thumbnail view i 

Default view style Background color 

1-3 • [Default ^j 

Default number of frames 

Toolbar 

f* Small Toolbar 

<~ Large Toolbar 

Unit 

<~ Inch 

Separation characters Communication Port Second/minute display 

«• (Tab) JC0M1 »] 

r a 
r f 

(s.m) 

Cancel 

(Fig. 17) 

For details, see the help message for the Configuration dialog box. 
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FIOO's Custom Setting 
You can set the Custom Setting options for the F100 camera via your personal com­
puter. You can also create Custom Setting files and print the file contents. 

Accessing the Custom Setting Dialog Box 
1 . Using the MC-33 or MC-31 cord, connect the F100 camera to a personal com­

puter. 
2. Turn on both the camera and personal computer. 
3. Start Photo Secretary, click "Tool" and "F100 Custom Setting" to activate the 

Custom Setting dialog box. (Fig. 18) 

Custom Setting JEs 

Dial/Buttons j Shooting] Film Operation j Autofocusj Exposure/flash photography | 

* t * i * " * m mmmmwAmm 
Aperture setting with lens' aperture ring j p j s a bled 

M 

d 
Auto Exposure/Flash Exposure Bracketing options JAEVSB Bracketing J 
Switching Command Dial operations j Disabled zl 

File Prim Default 

(Fig. 18) 

The Custom Setting dialog box allows you to: 
• Load the Custom Setting options data from the F100 camera. 
• Set Custom Setting options on the F100 camera. 
• Save the Custom Setting options as a file, or read the Custom Setting options data 

from an existing file. 
• Print the contents of the Custom Setting options. 
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Loading/Setting Custom Setting Options 
1 . On the Custom Setting dialog box, click "Load" to load the Custom Setting option 

data from the F100 camera body. The loaded data updates the dialog box con­
tents. 

2. Five tabs are provided with the Custom Setting dialog box: "Dial/Buttons", 
"Shooting", "Film Operation", "Autofocus" and "Exposure/Flash photography". 
They can be selected by clicking on their respective tabs. 
• For details see the help message for the Custom Setting dialog box. 
• Click "Default" to reset the Custom Setting options in the dialog box to the 

factory-set default status. 
3. Select desired options on each tab, then click "Set" to set the Custom Setting 

options you have selected on the F100 camera body. 

• If the Custom Setting status is different from the factory-set default status, BBfflgl 
appears in the F100 camera's LCD panel. 

Saving the Custom Setting Options Data As a File 
1 . On the Custom Settings dialog box, click "Save" to activate the Save As dialog 

box. (Fig. 19) 
2. On the Save As dialog box, type the desired name to save a file in the File Name 

column then select the file location. 
3. Click "Save" to save the file with a specified name in a specified location. 

Save in: _A Phot,., "3 ©J ffjfifM 
....."J Program 
I-.1 Sample 
[*] default pes 
1*1 nighttime, pes 
]*\ sports.pes 

Filename: 

Save as type: 

jmotorsports 

| F100 Custon iData 'pes) d Cancel 

(Fig. 19) 

If you specify the existing file name and location, the new data will replace the old 
data. 
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Loading the Custom Setting Option Data from an Existing File 
1 . On the Custom Setting dialog box, click "File" to activate the Open dialog box. 

(Fig. 20) 
2. On the Open dialog box, select the drive or folder where the desired file is located 

to display a list of files. Via the Photo Secretary, only Custom Setting options data 
files with the extension name "pes" can be opened. 

3. Select a file (or input file name) then click "Open" to open the file. You can also 
open the file by double-clicking the file name. Contents of the loaded data are 
shown in the Custom Setting dialog box. 

ESI •rra 
"_ i Photo Secretary 2 ~3 Jill s i [is jBl 

]*\ nighttime, p 

i*j sports, pes 

Qpen 

Fries of type; ]F100 Custom Data (".pes) d 

(Fig. 20) 

Printing the Custom Setting Option Data 
1 . On the Custom Setting dialog box, click "Print" to activate the Print dialog box. 

(Fig. 21) 
2. Select the printer, specify number of copies to be printed, then click "OK" to start 

printing. 
• For details, see the help message for the Print dialog box. 

BBS 

Status: Default printer; Ready 

Type: Type 01 Your Printer 

Where: LPTT: 

Print fange 

| - * l Properties j 

Number of copies: j ' 23 

[MM 
Q^x j Cancel 

(Fig. 21) 
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Shooting Data 
The Nikon F100, F5 and F90/F90X (or N90/N90s) cameras store shooting data in their 
memory databanks. Photo Secretary II allows you to select shooting data loading 
options, download shooting data from a camera to a personal computer, then display 
and edit shooting data. 

With the F100 
1. Using the MC-33 or MC-31 cord, connect the F100 camera to a personal computer. 
2. Turn on both the camera and personal computer. 
3. Start Photo Secretary, click "Tool" and "F100 Shooting Data" to activate the F100 

Shooting Data dialog box. (Fig. 22) 

F100 Shooting Data 

Memorize or not Memorise 

(• Memorize .shooting data 

f"" Nol memorise shooting data 

f* Simple mode 
f* Detailed mode 

Options with full data 

f~ Delete old data 
<* Stop shooting 

Confirm 

Modify 

:_^ I 
(Fig. 22) 

The F100 Shooting Data dialog box allows you to: 
• Confirm data loading options set on the F100 camera body. 
• Modify data loading options as desired and set them on the camera body. 
• Download shooting data from the F100's memory. 
• Delete shooting data from the F100's memory. 

Confirming data loading options 
You can confirm the data loading options set on the F100 camera body. 
On the F100 Shooting Data dialog box, click "Confirm" so that the dialog box shows 
data loading options set on the F100 camera body. 
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Modifying data loading options 
Data loading options can be modified when no shooting data is stored in the camera's 
memory and the film counter displays "E". The modified data loading options will be 
applied when the next roll of film is loaded and advanced to the first frame. 

1. On the F100 Shooting Data dialog box, select "Memorize shooting data" to store 
data or "Not memorize shooting data" to stop storing shooting data. ("Not memo­
rize shooting data" is the default setting.) 

2. If you have selected "Memorize shooting data", then select Simple mode or 
Detailed mode . 

3. You can choose to "Delete old data" or "Cancel shooting data memorization" 
when the camera's memory is full. ("Delete old data" is the default setting.) 

4. Click "Modify" to modify the data loading options on the camera body, as selected 
in the dialog box. 

• For details, see the help message for the F100 Shooting Data dialog box. 

F100 shooting data to be stored and data storage capacity: 

Type of data 
to be stored 

Simple mode 

Detailed mode 

Shooting data items 

Shutter speed, aperture, focal length set on the lens, 
frame counter, with or without Speedlight/ 
TTL auto flash, Multiple exposure 
All Simple mode items plus: lens' focal length, 
maximum aperture, metering system, exposure mode, 
flash sync mode, deviation from the correct exposure 
value and exposure compensation value in manual 
mode, flash output level compensation value 

Data storage capacity 
(no. of rolls of film) 

Approx. 70 

Approx. 30 

* When using 36-exposure film. Data storage capacity varies according to the 
number of frames shot. 
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Downloading shooting data from the F100 camera body. 
1 . On the F100 Shooting Data dialog box, click "Load" to activate the Data Loading 

dialog box. (Fig. 23) 

Data Loading 
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File name 

I * * . 
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Cancel 

(Fig. 23) 

On the Data Loading dialog box, input up to four letters for the first half of the file 
name. Then click "OK" to start downloading the shooting data. 

2. The loaded shooting data is saved with the specified name. The film number for 
the last half of the file name and file name extension ",psh" is automatically added 
to the file name. To open the saved shooting data file, click "File" and "Open". 

• To view style options for the shooting data files, see page 32. 
• For details, see the help message for the F100 Shooting Data dialog box. 

Deleting shooting data from the camera's memory 
1 . On the F100 Shooting Data dialog box, click "Delete" to activate the Data Deleting 

Confirmation message box. 
2. On the Data Deleting Confirmation message box, click "Yes" to delete shooting 

data. 
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Notes on memorizing and loading shooting data with the F100 
• Shooting data cannot be memorized until the camera has been loaded with film. 
• When shooting multiple exposures, the shooting data for the first exposure only will 

be memorized. 
• If the multiple exposure function is set, multiple exposures will be recorded even if 

the multiple exposure function is canceled after the first exposure. 
• To delete shooting data from the camera's memory, execute "Delete" on the F100 

Shooting Data dialog box (see page 22) or select "Delete old data" as an option 
with full data. 

• If you select "Delete old data" as an option with full data, memorizing new data 
when the camera's memory is full deletes the old data. Note that in this case, new 
data for one roll of film may delete old data for more than one roll of film. Depending 
on the number of exposed frames and other factors, new data for one roll of film 
may actually delete more than two rolls' worth of old data. 

• If you select "Stop shooting" as an option with full data, the shutter locks when the 
camera's memory is full. Also, a blinking "Full" indicator appears in place of the 
shutter speed indication in the camera's LCD panel. While in "Stop shooting" 
mode, turning the camera's power switch off, then on again, will make the full-
memory warning disappear, and you can continue shooting without memorizing 
data. To memorize shooting data, delete old data. Note that data loading options 
cannot be modified during shooting (they can be modified only when the frame 
counter shows "E"). We recommended that you always download shooting data 
from the camera's memory. For data storage capacity, see page 23. 

• The film speed set for the last exposed frame is memorized as shooting data. If you 
have modified the film speed in mid-roll, the previously set film speed will not be 
memorized. 

• If you download shooting data from the F100 camera in mid-roll, the shooting data 
for the film taken up to that point will also be downloaded. If you download the 
shooting data again after taking more pictures with the same roll, the newly down­
loaded shooting data is saved with the same name as the previously saved data. 
This will replace the older data. To avoid this, input a different file name on the Data 
Loading dialog box or modify the file name of the old data. 
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With the F5 
1. Using the MC-33 cord, connect the F5 camera to a personal computer. 
2. Turn on both the camera and personal computer. 
3. Start Photo Secretary, click "Tool" and "F5 Shooting Data" to activate the F5 

Shooting Data dialog box. (Fig 24) 

r 
fi­

l l ph 

r 
a 

' ful l 

r. 
r 

c 
fi 

ms^hfuHdala 

Delete old daia 
Hoi deleting olddata 

memotv" watwtg 

Aelivate 
Not activate 

(Fig 24) 

The F5 Shooting Data dialog box allows you to: 
• Confirm data loading options set on the F5 camera body. 
• Modify data loading options as desired and set them on the camera body 
• Download shooting data from the F5's memory 
• Delete shooting data from the F5's memory 

Confirming data loading options 
You can confirm data loading options set on the F5 camera body. 
On the F5 Shooting Data dialog box, click "Confirm" so that the dialog box shows the 
data loading options set on the F5 camera body. 

Modifying data loading options 
You can modify data loading options to suit your needs. 
The modified data loading options will be activated after you load a new roll of film 
and it advances to the first frame. 

On the F5 Shooting Data dialog box, select the data to be stored from types A, B, 
C and D. (For details on the types of data to be stored, see page 27.) 
Choose whether you want to delete old data or stop memorizing shooting data 
when the camera's memory is full. 
Choose whether you activate the full-memory warning or not. 
Click "Modify" to modify the data loading options on the camera body, as selected 
in the dialog box. 

For details, see the help message for the F5 Shooting Data dialog box. 
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F5 shooting data to be stored and data storage capacity: 
Type of data 
to be stored 
A 

B 
C 
D 

Shooting data items 

Shutter speed, aperture, focal length, film counter, lens 
maximum aperture 
Type A items plus: shooting date and time 
Type B items plus: imprinted letters 
Type C items plus: metering system, exposure mode, 
sync mode, deviation from the correct exposure value 
and exposure compensation value in manual mode 

Data storage capacity 
(no. of rolls of film) 

Approx. 78 
Approx. 36 
Approx. 12 
Approx. 10 
(or approx. 39 rolls 
without the MF-28) 

* When using 36-exposure film. Data storage capacity varies according to the num­
ber of frames shot and/or if multiple exposure shooting is conducted. Types B and 
C items can be stored only when the Multi-Control Back MF-28 is attached. 
Without the MF-28, you can only store type A items even if you select types B or C. 

Downloading shooting data from the F5 camera body 
You can download shooting data from the F5 camera body. 

1. On the F5 Shooting Data dialog box, click "Load" to activate the Data Loading 
dialog box. (Fig. 25) 

(Fig. 25) 

On the Data Loading dialog box, input up to four letters for the first half of the file 
name. Then click "OK" to start downloading the shooting data. 

2. The loaded shooting data is saved with the specified name. The film number for 
the last half of the file name and file name extension ".psh" is automatically added 
to the file name. To open the saved shooting data file, click "File" and "Open". 

• To view style options for shooting data files, see page 32. 
• For details, see the help message for the F5 Shooting Data dialog box. 
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Deleting shooting data from the camera's memory 
1 . On the F5 Shooting Data dialog box, click "Delete" to activate the Data Deleting 

Confirmation message box. 
2. On the Data Deleting Confirmation message box, click "Yes" to delete shooting 

data. 

Notes on memorizing, loading shooting data with the F5 
• Shooting data cannot be memorized until the camera has been loaded with film. 
• Month, day, hour, minute, second and imprinted letters items can be memorized 

only when the Multi-Control Back MF-28 is attached. 
• When shooting multiple exposures, the selected data items will be loaded for first 

exposure. 
• When the camera is loaded with film, shooting data is always memorized — even 

for test shooting. 
• To delete shooting data from the camera's memory, select "Delete" on the F5 

Shooting Data dialog box (see page 26) or select "Delete old data" as an option 
with full data. 

• If the camera's memory becomes full after you have selected data loading options 
that activates the full-memory warning, the personal computer connection symbol 
blinks in the camera's rear LCD panel. 

• If you select "Delete old data" as an option with full data, memorizing new data 
when the camera's memory is full deletes the old data. 
(The personal computer symbol in the rear LCD panel blinks telling that some data 
has been deleted.) Frequent downloading of shooting data is recommended. For 
data storage capacity, see page 27. 

• If you change the film speed with the frame counter showing " 1 " or higher, this will 
not affect the shooting data. The previous set film speed will be memorized for the 
shooting data download operation. 
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With the F90/F90X (N90/N90s) 
1. Using the MC-31 cord, connect the F90/F90X (N90/N90s) camera to a personal 

computer. 
2. Turn on both the camera and personal computer. 
3. Start Photo Secretary, click "Tool" and "F90/F90X (N90/N90s) Shooting Data" to 

activate the F90/F90X (N90/N90s) Shooting Data dialog box. (Fig. 26) 
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(Fig. 26) 

The F90/F90X (N90/N90s) Shooting Data dialog box allows you to: 
• Confirm data loading options set on the F90/F90X (N90/N90s) camera body. 
• Modify data loading options as desired and set them on the camera body. 
• Download shooting data from the F90/F90X (N90/N90s) camera's memory. 
• Delete shooting data from the F90/F90X (N90/N90s) camera's memory. 

Confirming data loading options 
You can confirm the data loading options set on the F90/F90X (N90/N90s) camera 
body. 

On the F90/F90X (N90/N90s) Shooting Data dialog box, click "Confirm" so that the 
dialog box shows data loading options set on the F90/F90X (N90/N90s) camera 
body. 
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Modifying data loading options 
Data loading options can be modified only when no shooting data is stored in the 
camera's memory and the film counter shows "E". The modified data loading options 
will be activated after you load a new roll of film and it advances to the first frame. 

1. On the F90/F90X (N90/N90s) Shooting Data dialog box, select one of the four 
memory modes: "Cancel storage of shooting data," "Store minimum shooting 
data", "Store medium shooting data", and "Store maximum shooting data". 
("Cancel storage of shooting data" is the default setting.) 

2. Select one of the following options: "Turn power switch OFF then ON" or 
"Download stored data". ("Turn power switch OFF then ON" is the default setting.) 

3. Click "Modify" to modify the data loading options on the camera body, as selected 
in the dialog box. 

• For details, see the help message for the F90/F90X (N90/N90s) Shooting Data dia­
log box. 

F90/F90X (N90/N90s) shooting data to be stored and data storing capacity: 

Type of data 
to be stored 

Minimum data 

Medium data 

Maximum data 

Shooting data items 

Shutter speed, aperture 
"Minimum data" items plus metering system, 
exposure mode, flash sync mode, focal length set 
on the lens 
"Medium data" items plus exposure 
compensation value, flash output level 
compensation value 

Data storing capacity 
(no. of rolls of film) 
F90/N90 
Approx. 5 

Approx. 3 

Approx. 2 

F90X/N90S 
Approx. 99 

Approx. 50 

Approx. 34 

* When using 36-exposure film. Data storage capacity varies according to the 
number of frames shot and/or if multiple exposure shooting is conducted. 

Downloading shooting data from the F90/F90X (N90/N90s) camera body 
1. On the F90/F90X (N90/N90s) Shooting Data dialog box, click "Load" to activate 

the Data Loading dialog box. (Fig. 27) 

(Fig. 27) 
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On the Data Loading dialog box, input up to four letters for the first half of the file 
name. Then click "OK" to start downloading the shooting data. 

2. The loaded shooting data is saved with the specified name. The film number for 
the last half of the file name and file name extension "*psh" is automatically added 
to the file name. To open the saved shooting data file, click "File" and "Open". 

• To view style options for shooting data files, see page 32. 
• For details, see the help message for the F90/F90X (N90/N90s) Shooting Data dia­

log box. 

Deleting shooting data from camera's memory 
1 . Click "Delete" to activate the Data Deleting Confirmation message box. 
2. On the Data Deleting Confirmation message box, click "Yes" to delete shooting 

data. 

Notes on memorizing, loading shooting data with F90/F90X (N90/N90s) 
• Shooting data cannot be memorized until the camera has been loaded with film. 
• When shooting multiple exposures, the shooting data for the first exposure only will 

be memorized. 
• To delete shooting data from the camera's memory, select "Delete" on the F90/ 

F90X (N90/N90s) Shooting Data dialog box (see page 29), or download shooting 
data from the F90/F90X (N90/N90s) camera. 

• If you download shooting data from the F90/F90X (N90/N90s) camera in mid-roll, 
the shooting data for film taken up to that point is not downloaded. Only the previ­
ously memorized data from other rolls is downloaded and then deleted. 

• If you have modified Memory Mode option on the F90/F90X (N90/N90s) Shooting 
Data dialog box, WIMBWI appears in the camera's LCD panel. 

• The "Delete" command on the F90/F90X (N90/N90s) Shooting Data dialog box can 
be executed even when the film is in mid-roll. In this case, all shooting data except 
for that of the film roll in use, will be deleted from the camera's memory. 

• Option for "Data imprinted on frame #0" cannot be set. 
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Opening Shooting Data Files 
In the Photo Secretary application, click "File" and "Open" to activate the Open dialog 
box (Fig. 28). Select your desired file and click "Open", or double-click the icon for the 
file, to display the shooting data. You can open a shooting data file when another file 
is already open. 
With Photo Secretary, you can open files with the following file name extensions: 
• ".psh" (Photo Secretary II for F100 file format) 
• ",F5" (Photo Secretary for F5 file format) 
• ".nkn" or ",f90" [Photo Secretary for F90/F90X (N90/N90s) file format] 

With Photo Secretary II for F100, the file name extension ".psh" is automatically 
added to the file name of a newly created file. It cannot be changed. 

Look in: „ J Sample 

E ^ Autumn, psh 
^ V Drive, psh 

E y Winter, psh 

File came: || 

Fifes of type: 3 All shooting data N sf.psrvMS;* 

"3 M 

nknl zl 

2, 

| Open 

Cancel 

(Fig. 28) 

Selecting Shooting Data File Views 
You can choose "List" (Fig. 39), "Text" (Fig. 30), "Film" (Fig. 31), "Thumbnail" (Fig. 32) 
and "Thumbnail & List" (Fig. 33) as view styles for shooting data files. Select the 
desired view style from the View menu. When two or more shooting data files are 
open, first click on the shooting data display window to activate the file you want to 
change, then follow the procedure below. 
With any view style, the title, comment and film speed are displayed at the top of the 
shooting data display window. 
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(Fig. 33) Thumbnail List view 

You can edit the active shooting data file; you can also link image data to the active 
shooting data file. (Pages 36-42). 
The "Configuration" command in the Tool menu allows you to select the following 
view style options: 
a) You can set the default view style as you wish from the available view options. 
b)You can select shooting data items to be displayed in Text, Film or Thumbnail 

view. You can also set the number of frames per row and line space length. 
c) You can choose a background color for the window. (Note: on printouts, the 

background color will be white.) 
For details, see the help message for the "Configuration" command. 

Using the "Title Font" command in View menu, you can select a font for the title. 
You can also select a font for frame data with the "Frame Font" command. 
To execute the "Print" command, print the active window with the selected view 
style. (Pages 45-48) 
With Film, Thumbnail or Thumbnail List view, you can use the "Slide Show" com­
mand to display the linked images, one by one, by frame number order. The "Slide 
Show" command is in the Tool menu. 
For details, see the help message for each view style. 
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Editing Shooting Data 
Photo Secretary allows you to edit shooting data and link image data to the shooting 
data. 

Selecting "Data Property" Options 
You can specify general information about the shooting data. 
1. Open the file (i.e., click "File" and "Open" then select desired file). Or, if two or 

more shooting data files are already open, click on the shooting data display win­
dow you want, to activate it. Click "Tool" and "Data Property" to activate the Data 
Property dialog box (Fig. 34). On the Data Property dialog box, you can select from 
a range of options. 

Data Property 

Number of frames First frame 
_ j 

OK 
—I-,*-

Cancel 

Title 

jBayside driving 

Comment 

jFrorn Chiba to Yokohama 

Film speed 

p™ 3 

(Fig. 34) 

2. On the Data Property dialog box, input the title and comment you want. You modi­
fy the title and comment later as desired. 
For Film view, set the location of the first frame and change the number of frames. 

3. Click "OK". 
• For details, see the help message for the Data Property dialog box. 
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Selecting "Frame Property" Options 
1. Open the file (i.e., click "File" and "Open" then select desired file). With a view style 

other than "Film" view: Click on the frame you want to edit to activate it, then click 
"Tool" and "Frame Property" to activate the Frame Property dialog box (Fig. 35). 
The Frame Property dialog box can also be activated by double-clicking on the 
desired frame data. 
With "Film" view: Click on the frame you want to edit to activate it, click on the 
right-hand button on the mouse then click "Property" to activate the Frame 
Property dialog box (Fig. 35). 
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(Fig. 35) 

2. On the Frame Property dialog box, edit the shooting data as desired then click "OK". 
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Linking Image Data to Frames 
1. Open the shooting data file (i.e., click "File" and "Open" then select desired file) or 

create a new file (i.e., click "File" and "New"). Select "Film", "Thumbnail" or 
"Thumbnail List" view so that the thumbnail image will be displayed. 

2. Click and activate the frame to which you want to link the image data. 
3. Click "Tool" and "Edit Image" to open the Photo Finder (Fig. 36) 

You can also open the Photo Finder by double clicking the thumbnail image area 
(with or without the thumbnail image displayed) of the frame. 

(Fig. 36) 

4. Load the image data from a scanner or photo CD, or open other image data files. 

• For compatible image data formats, see page 50. 
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On the Photo Finder window, click "File" and "Exit" and return to file name. If you 
have downloaded image data from a scanner or Photo CD, or if you have modified 
an image data file, the Save Confirmation box (Fig. 37) will appear. Select "Yes" to 
quit the Photo Finder. The loaded image data is automatically linked to the select­
ed frame of the shooting data. 

Photo F 

Js 
nder Q [ 

Save changes to C:\Program Files\NiKon\Photo Secretary 2V3ample\PS2_Q38.jpg ffe? 

M Yes Ĵ o Cancel 

(Fig. 37) 

You can move the image data from one frame to another using drag-and-drop editing. 

To see the original data of the pasted image, select the frame where the desired 
image data is pasted, then click "Tool" and "Edit Image". 

• The image data downloaded from a scanner or other image-capturing device, or 
moved from the clipboard, must be saved as an image data file. 

• For information about compatible image data file formats, see page 50. 
• For details, see the help message for each function. 
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Using the "Load Multiple Images" Command 
to Link Image Data to Shooting Data 
You can load image data continuously from a scanner1'. The loaded image data is 
automatically linked to frames of the shooting data and saved2'. 

1) Requires a scanner having a continuous loading function with auto feed. 
Continuous loading of image data may not occur with some scanners, even if 
they have a continuous loading function with auto feed. 

2) A large-size image data file has a volume size of some MB. Make sure there is 
sufficient disk memory before continuously loading image data. 

To link image data to frames, select the Film view, Thumbnail view or Thumbnail List 
view. With the List view or Text view, linking image data to frames cannot occur. 
With two or more shooting data windows open, click on the one you want to activate 
it, then select the frame to be linked with the image data. 

1. Click "Load Multiple Images" in the Photo Secretary's Tool menu to activate the 
Load Multiple Images dialog box (Fig. 38). 

Load Multiple Images 

C:\Prograrn Files\Nikon\Photo Secre 

Frame number for starting y T j 

Number of frames 

KJ 

Image data file 

Heading Letter |Film1| 

Starting Numbei JO - j j 

File Format 
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(Fig. 38) 
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2. On the Load Multiple Images dialog box, specify and select options for loading 
image data. 
• For details, see the help message for the Load Multiple Image dialog box. 

3. After setting options, click "OK" to activate the Select Source dialog box (Fig. 39). 
The Select Source dialog box shows the list of available TWAIN equipment. If you 
select JPEG, TIFF or FlashPix as a file format, the JPEG Option dialog box, the 
TIFF Option dialog box or the FlashPix Option dialog box will be activated instead. 
• For details, see the help message for each dialog box. 

(Fig. 39) 

4. On the Select Source dialog box, select the scanner by clicking it, then click 
"Select" to activate the TWAIN Input dialog box. 
Methods of setting options on the TWAIN Input dialog box depend on the scanner 
in use. For details, refer to your scanner operating manual. 
• If your scanner lacks an auto feed function for continuous loading, an error 

message informs you that continuous loading of images cannot be performed. 
Then the "Load Multiple Image" command will be canceled. 

5. Start scanning. 
The image data is loaded, then linked to the shooting data frames continuously. 
After multiple loading of image data is completed, the shooting data frames show 
thumbnail images of the linked image data. 
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Using the "Image List" Command to Link Image Data to 
Shooting Data 
You can display a list of thumbnail images of an existing image data file regardless of 
where they are located. Any of the listed images can be linked to the shooting data 
frame by drag-and-drop editing. 

1. Click "Image List" in the Photo Secretary's Tool menu to activate the Open dialog 
box (Fig. 40). 

2. Click the desired file icon to select it on the Open dialog box. 
To select two or more files, click the file icon while pressing the Ctrl key or shift 
key. 

3. Click "Open" to display a list of thumbnail images of selected image data on the 
image list window. 

4. Drag-and-drop the desired thumbnail image to the frame on the shooting data 
window to link the data to the frame. 
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• Note: displaying several large-sized images may take a lot of time. 
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Searching Files Based on Keyword 
You can search the shooting data files that contain the specified keywords without 
actually opening the file. Shooting data files containing the specified keywords are 
also searched. 

1. Click "Find" in the File menu to activate the Find Data dialog box (Fig. 41). 
2. On the Find Data dialog box, specify folder and keywords. Type in two or more 

words with space to find files that contain all the words you specified. 
3. Click "Find" to start searching. The searched shooting data files are listed in the 

Find Result box on the Find File dialog box. 
4. Double-click the desired file in the Find Result box to open it. 

Check "Whole Word" to search only for the words/characters that match the speci­
fied keywords. (For example, "F50" and "Nikon-F5" will not be detected when you 
input "F5" as the keyword). 
Check "Ignore Case" to ignore case (uppercase or lowercase letters) in the search 
function. 
For details, see the help message for the Find Data dialog box. 
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Saving the Shooting Data as Text Files 
You can save the shooting data files as text files (having file name extension "*.txt") to 
see the file contents via the other applications. To save the shooting data files as text 
files, use the "Save As" command. 
In a text file converted from a shooting file, the first line shows the shooting data prop­
erty and after the second line shows the frame property (Fig. 43). With the 
"Configuration" command in the Tool menu, you can specify characters or marks to 
separate shooting data columns and second/minute display style for shutter speed 
indication. For details, see the help message for "Configuration". 

1. Open the file (i.e., click "File" and "Open" then select the desired file). Or, if two or 
more shooting data files are already open, activate the desired one by clicking it. 
Click "File" and "Save As" to activate the Save As dialog box (Fig. 42). 

2. On the Save As dialog box, input file name, select "*.txt" as file type, then click 
"Save" to save the file as a text file. 

(Fig. 42) 

Text files cannot be opened via Photo Secretary. Use WordPad or Notepad to con­
firm contents of text files. 
For details, see the help message. 
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Printing the Shooting Data 
Performing the "Print" command prints the shooting data file as displayed in the win­
dow. If necessary, change the view style of the shooting data with the command in 
the View menu ("List", "Text", "Film", "Thumbnail" or "Thumbnail List"). 

With List view: You can select the number of displayed items of shooting data— 
Simple List, Normal List or Detailed List. 
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With Text view: 
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With Film view: Thumbnail images are printed in film sleeve format. Frames not linked 
with any image data show shooting data items. 
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With Thumbnail view: 
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(Fig. 47) 

47 



With Thumbnail List view: 

(Fig. 48) 

Setting print options 
1 . Click "Print Setup" in the File menu to activate the Print Setup dialog box. 
2. Select paper size, paper orientation and other print options on the Printer Setup 

dialog box. If two or more printers are usable, select one printer. 
For details, see the help message for the Printer Setup dialog box. 

3. After setting options, click "OK". 

Confirming print results 
1 . Click "Print Preview" in the File menu to display print result of the active shooting 

data file. For details, see the help message for the "Print Preview" command. 
2. To close the Print Preview and return to the normal shooting data display window, 

click the "Close" button on the Print Preview Toolbar. 

Printing 
1 . Click "Print" in the File menu to activate the Print dialog box. 
2. Specify the pages to be printed and the number of copies to be printed. Then click 

"OK" to start printing. 
For details, see the message for the Print dialog box. 
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PHOTO FINDER 

Photo Finder is an image data loading application of Nikon Photo Secretary II for 
F100. Photo Finder can be started up independently. However, in most cases, it is 
started up via Photo Secretary. Photo Finder allows you to load image data from a 
scanner or other equipment, or Photo CD. The loaded image data can be edited and 
saved as files. ("Image List" and "Load Multiple Images" commands are available in 
Photo Secretary.) 
Started via the Photo Secretary when shooting data is linked to the image data, the 
Photo Finder sends information about image to the Photo Secretary. 

(Fig. 49) 

Photo Finder offers the following functions: 
• Opens image data files such as Bitmap, JPEG, TIFF and FlashPix files. 
• Downloads image data from data input equipment such as a scanner, etc. 
• Opens image data files from Photo CD. 
• Rotates image 90 degrees to left or right. 
• Changes display size of image. 
• Changes picture size. 
• Saves displayed image as an image data file such as Bitmap, JPEG or FlashPix file. 
• Prints the displayed image and shooting data. 

For details, see the help messages for Photo Finder. 
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Usable Image Data Files with Photo Secretary I I for F100 

Following image data can be used: 
• Bitmap files (having file name extension of ".bmp") 
• JPEG files (having file name extension of ".jpg" or "jpe") 
• TIFF files (having file name extension of ".tif") 
• Photo CD files (having file name extension of ".pcd")* 
• FlashPix files (having file name extension of ".fpx") 

• Image data cannot be saved as Photo CD files. 
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KEYBOARD SHORTCUTS 
Nikon Photo Secretary I I for F100 offers the following keyboard shortcuts: 

General Windows® keys 
ALT+TAB Shift active window to the right or downward. 
ALT+SHIFT+TAB Shift active window to the left or upward. 
ALT+SPACE Display system menu bar for current window. 
ALT+ designated character key 

Selects the corresponding menu from the system menu bar of 
the current window. (Press the underlined character key in the 
system menu bar.) 

CTRL+ESC Activate start menu. 

For Photo Secretary II for F100 keys 
<= Shift the menu selection to the left. 
=> Shift the menu selection to the right. 
ft Shift the menu selection upward. 
Ji Shift the menu selection downward. 
J Perform the selected command. 
ESC Cancel the selected menu. 

For dialog boxes 
TAB Move downward through options. 
SHIFT+TAB Move upward through options. 
SPACE Confirm the selected control button. 
RETURN Perform the operation using the default setting. 
*= Shift the currently active item. When a tab on the dialog box is select­

ed, open the page to left of the selected tab. 
=> Shift the currently active item. When a tab on the dialog box is select­

ed, open the page to right of the selected tab. 
11 Shift the currently active item/numerical value upward. 
•I! Shift the currently active item/numerical value downward. 
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